COURSE CHANGE REQUEST Last Updated: Haddad,Deborah Moore

3597.01 - Status: PENDING 05/28/2016
Term Information
Effective Term Spring 2017
Previous Value Spring 2014

Course Change Information

What change is being proposed? (If more than one, what changes are being proposed?)

Add GE Category: Diversity-Global Studies

What is the rationale for the proposed change(s)?

Since its inception, this course has focused on global issues and addressed the goals and ELOs of this GE category. This change will bring the GE status in
line with the content and focus of the course.

What are the programmatic implications of the proposed change(s)?

(e.g. program requirements to be added or removed, changes to be made in available resources, effect on other programs that use the course)?
None

Is approval of the requrest contingent upon the approval of other course or curricular program request? No

Is this a request to withdraw the course? No

General Information

Course Bulletin Listing/Subject Area Sociology

Fiscal Unit/Academic Org Sociology - DO777

College/Academic Group Arts and Sciences

Level/Career Undergraduate

Course Number/Catalog 3597.01

Course Title World Problems in Global Context

Transcript Abbreviation World Probs Global

Course Description Sociological analysis of contemporary world societies - non-industrialized, industrializing, and
industrialized - with special attention to major social institutions and patterns of social change.

Semester Credit Hours/Units Fixed: 3

Offering Information

Length Of Course 14 Week, 12 Week, 8 Week, 7 Week, 6 Week
Flexibly Scheduled Course Never

Does any section of this course have a distance Yes
education component?

Is any section of the course offered Greater or equal to 50% at a distance

Grading Basis Letter Grade

Repeatable No

Course Components Lecture

Grade Roster Component Lecture

Credit Available by Exam No

Admission Condition Course No

Off Campus Never

Campus of Offering Columbus, Lima, Mansfield, Marion, Newark
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COURSE CHANGE REQUEST Last Updated: Haddad,Deborah Moore
3597.01 - Status: PENDING 05/28/2016

Prerequisites and Exclusions

Prerequisites/Corequisites
Exclusions Not open to students with credit for 597.01.

Cross-Listings

Cross-Listings

Subject/CIP Code

Subject/CIP Code 45.1101
Subsidy Level Baccalaureate Course
Intended Rank Senior

Requirement/Elective Designation

General Education course:
Global Studies (International Issues successors); Cross-Disciplinary Seminar (597 successors and new)
The course is an elective (for this or other units) or is a service course for other units

Previous Value
General Education course:

Cross-Disciplinary Seminar (597 successors and new)
The course is an elective (for this or other units) or is a service course for other units

Course Details

Course goals or learning ® Sociological analysis of contemporary world societies - non-industrialized, industrializing, and industrialized - with
objectives/outcomes
special attention to major social institutions and patterns of social change.
® Students understand the benefits and limitations of different disciplinary perspectives.
® Students understand the benefits of synthesizing multiple disciplinary perspectives.

® Students synthesize and apply knowledge from diverse disciplines to a topic of interest.
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COURSE CHANGE REQUEST
3597.01 - Status: PENDING

Last Updated: Haddad,Deborah Moore
05/28/2016

Content Topic List

Attachments

Comments

Workflow Information

® Globalization

® Development

® Political regimes

® Human rights

® Foreign aid

® Conflict

® Natural resources

® Poverty

® Food & water security
® Health

® Environment

® Population - urbanization & migration
® Education

® Culture

® Religion

® Social Movements

® GE Rationale SOC 3597 01x.docx: GE Rationale and Assessment

(GEC Course Assessment Plan. Owner: Williams,Kristi L.)
® SOCIOL 3597 syllabus fall 2014.docx

(Syllabus. Owner: Williams,Kristi L.)

® Official Sociology Crim Curriculum Map April 2016.xIsx: Curriculum Map

(Other Supporting Documentation. Owner: Williams,Kristi L.)

® A heads-up: Neither the SBS Panel nor the full ASCC Committee meet over the summer. The division and the

college will begin the vetting process for this request during AU16. (by Haddad,Deborah Moore on 05/28/2016 04:15 PM)

Status O] Date/Time Step
Submitted Williams, Kristi L. 05/27/2016 02:19 PM Submitted for Approval
Approved Williams,Kristi L. 05/27/2016 02:20 PM Unit Approval
Approved Haddad,Deborah Moore | 05/28/2016 04:15 PM College Approval

Nolen,Dawn
Vankeerbergen,Bernadet
te Chantal

Pending Approval
Hanlin,Deborah Kay

Jenkins,Mary Ellen Bigler

Hogle,Danielle Nicole

05/28/2016 04:15 PM

ASCCAO Approval
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Sociology 3597.01 - World Problems in Global Context
Section 24531
Tuesdays and Thursdays, 9:35 — 10:55 am
Caldwell Lab room 0133
Prof. Tim Bartley, Ph.D.
Office: Townshend Hall 219
Office Hours: Tues. and Thurs. 4:00-5:30
bartley.83@osu.edu ph: 614-688-1364

Course Description

This course examines social problems around the world and their relationship to globalization—that is,
the increasing connectedness of social and economic life across borders. Global problems can often
seem overwhelming, confusing, and disconnected from our daily lives, but this course seeks to clarify
their links to personal experiences, both here and elsewhere. The course will also put particular global
problems in the context of larger structures of global order (like states, markets, systems of governance,
and gender hierarchies) and processes of social change over the past century.

We will take a global perspective and examine a wide array of problems in various parts of the world
(e.g., Asia, Africa, South America, and North America), but we will also develop a more in-depth focus on
a few key sites and a few key processes of globalization. Specifically, we will consider how systems of
global production tie us as consumers to issues of labor rights, social justice, and environmental
sustainability in other parts of the world. We will focus at several points on China and Southeast Asia to
get a deeper understanding of some particular locations. In addition, you will be asked to choose a
country that can serve as a focal point for your own inquiry throughout the semester. In addition to the
required readings, you will be asked to learn a bit about that country, and you will perform some data
analysis that situates that country in its larger context.

By the end of the semester, | hope you will have gained the following:
1. a clearer sense of your connection to individuals, communities, and environments in other parts
of the world;
2. a deeper understanding of globalization, including its history, ideological foundations, and
complex consequences;
3. substantive knowledge of the interplay of global production and social life in particular countries;
4. greater skill in understanding and evaluating complex written arguments;
5. some experience analyzing quantitative, cross-national data.

If you work hard in this course, you will not only learn about world problems, you will develop analytical
skills that you can carry to future endeavors. On the other hand, if you are not willing to work hard and
invest time in this course, you will find it very difficult to do well, and you will miss an opportunity to
expand your horizons and skills.


mailto:bartley.83@osu.edu

This course also fulfills a General Education Cross-Disciplinary Seminar requirement, which means that
the course also has the following goals and expected outcomes. Goals: Students demonstrate an
understanding of a topic of interest through scholarly activities that draw upon multiple disciplines and
through their interactions with students from different majors. Expected Learning Outcomes:

1. Students understand the benefits and limitations of different disciplinary perspectives.
2. Students understand the benefits of synthesizing multiple disciplinary perspectives.
3. Students synthesize and apply knowledge from diverse disciplines to a topic of interest.

We will seek to meet these goals and expected outcomes by considering perspectives on globalization,
states, and markets from several disciplines (especially sociology and economics, with some political
science, anthropology, and history present as well), by applying these perspectives to issues of labor
rights, social justice, and sustainability, and by engaging in dialogue about these perspectives with other
students in the class.

<TO BE ADDED UPON GE-GLOBAL STUDIES APPROVAL>

This course also fulfills a General Education Diversity-Global Studies requirement, which means that the
course also has the following goals and expected outcomes. Goals: Students understand the pluralistic
nature of institutions, society, and culture in the United States and across the world in order to become
educated, productive, and principled citizens. Expected Learning Outcomes:

1. Students understand some of the political, economic, cultural, physical, social, and philosophical
aspects of one or more of the world's nations, peoples and cultures outside the U.S.

2. Students recognize the role of national and international diversity in shaping their own attitudes
and values as global citizens.

We will seek to meet these goals and expected outcomes by considering perspectives on globalization,
states, and markets from several disciplines (especially sociology and economics, with some political
science, anthropology, and history present as well), by applying these perspectives to issues of labor
rights, social justice, and sustainability, and by engaging in dialogue about these perspectives with other
students in the class.

Readings

Two books are required and are available for purchase at the OSU Bookstore and elsewhere:

Timmerman, Kelsey. 2012. Where am | Wearing: A Global Tour to the Countries, Factories, and People
That Make Our Clothes. Wiley (2" edition)

Chang, Leslie T. 2009. Factory Girls: From Village to City in a Changing China. Spiegel & Grau.

Other required readings (see the schedule below) will be posted on Carmen. | highly recommend that
you download and print them so that you can read them carefully, make notes on them, and have
access to them during class.

Course Requirements




Choose a Country: The readings and class materials will provide a glimpse of a variety of places around
the world. But to develop a deeper understanding of a particular place, you should choose one of the
following countries to have as your special focus throughout the semester: Indonesia, Bangladesh,
China, Cambodia, Mexico, Honduras, Congo (DRC). Each of these is featured in one or more of our
assigned readings. In addition, you will be asked to do some independent reading about this country,
and it will be featured in your two project assignments (discussed below).

Engagement with the Readings: Reading is a crucial component of this class. You are expected to
complete all readings by the date on which they are assigned and to be prepared to participate in
discussions, raise additional questions, answer questions about the readings in class. | have carefully
selected readings that | believe are provocative, insightful, and sometimes fun. Some of these readings
are also complex, either because they take you into previously unknown territory or because they make
complex and nuanced arguments. You should set aside blocks of time prior to our Tuesday and
Thursday meetings that you can devote to reading for this class. Sometimes, you may need to read a
piece twice in order to fully grasp it.

Attendance and participation: Our class sessions will be a mix of lectures, discussion, and other
activities. To do well in this class, it is essential that you are present, prepared, and engaged in all class
sessions. The material presented in lectures and discussions will go well beyond what is in the readings,
and both lecture and reading material will appear on exams. In addition, you will be part of a small
group throughout the semester, and you are expected to vigorously contribute to your group’s
discussions and inquiries. If you do miss a class, your first step should be to talk with your group
members to find out how to catch up.

You can earn up to 30 points (roughly 10% of the total) for being present and actively engaged in every
class session. (Being actively engaged means that you don’t allow yourself to get distracted, you
frequently contribute to discussions, and your contributions are informed by the readings and other
course materials. Poor attendance and/or a lack of active participation will make it difficult to earn even
half of these points.) | will periodically take notes on your individual and group contributions, and | will
be happy to share my comments on your participation after class or during office hours.

Project Reports: You will be working on two short projects, each of which will require a brief written
report. The first will use your own consumer activities to explore links to individuals, communities, and
environments elsewhere (with a particular emphasis on your country of choice). The second will ask you
to analyze some data on national development and to examine your country’s position in the global
pattern. (I will provide instructions on data analysis, so no prior skills are necessary.) The specific
assignments will be distributed at least a week and a half prior to the due dates (which are noted on the
schedule). You can earn up to 25 points for each assignment.

Quizzes: Short quizzes will be given at the beginning of nine class sessions. (See the dates marked with
a “Q” on the schedule.) These will cover the readings assigned for that day, as well as the readings from
one class prior to that. | believe that frequent quizzes are important for helping you to keep up with the
readings and for tracking your understanding of them. Each quiz is worth 10 points. Your lowest two



quiz scores will be dropped from the calculation of your final grade. Accordingly, make-up quizzes will
not be offered. (If truly extraordinary circumstances cause you to miss class (like a serious, extended
iliness), AND you have documentation of these circumstances, AND you have notified me by email,
phone, or in person prior to the start of class, you may be eligible to complete an alternative assignment
to replace the quiz.)

If you have read carefully and grasped the key arguments of the assigned reading, the quizzes should be
relatively easy. But just looking at the readings is not the same as reading them carefully. If you have
not read carefully or have not invested enough to grasp the key arguments, you will struggle to earn
more than a few points on each quiz. Since your lowest two scores are dropped, you have a couple of
chances to make mistakes or be confused without it affecting your grade. (Even a careful reader
occasionally forgets or misses key points.)

Exams: There are two exams—a midterm and a final. Each will consist of multiple choice and short
essay questions. The final exam will cover material from the second portion of the class plus some
cumulative knowledge from the class as a whole. The midterm is worth 60 points and the final is worth

80 points.

Grading

Top 7 quizzes 70 points
Midterm exam 60 points
Final exam 80 points
2 project assighments 50 points
Participation 30 points

290 points total
Final grades will be based on the number of points you earn as a percentage of the total points possible.

A 93-100% B- 80-82% D+ 67-69%
A- 90-92% C+ 77-79% D 60-66%
B+ 87-89% C 73-76% E 59% or less
B 83-86% C- 70-72%

Note: If everyone in the class (at least 95%) responds to the Student Evaluation of Instruction by the last
day of class, then | will round up to the nearest percentage when assigning final grades (e.g., an 89.01%
would be rounded up to 90% and result in an A-).

Policy on classroom etiquette

This is a challenging and interactive class. Respect for the material, for each other, and for the
classroom environment is essential. At a minimum, this means that we must be willing to communicate
openly and be active listeners of each other. Distractions make such an environment very difficult to
sustain. Cellphones must be turned off or silenced and put away during class time. In addition, |

strongly discourage the use of laptops in class. Itis hard to resist the distractions they offer and even



harder to make your attention clear to others when you are using a laptop. (If there is an important
reason that you must use a laptop, let’s talk about appropriate times and ways to do so.) In general,
please try to minimize disruptions (e.g., coming and going during class) and demonstrate sustained
engagement in each class session.

Policy on late work and missed exams

In general, you are expected to complete all work at the scheduled time. No make-up exams will be
given or late work accepted unless the situation meets all of the following criteria: (1) Truly
extraordinary and unavoidable circumstances cause you to miss the class AND (2) you have
documentation to prove these circumstances AND (3) you notify me in advance (by email, phone
message, or in person).

Statement on Academic Integrity

You are expected to ensure that your work for this class is of the highest quality and the result of your
own work. Cheating on quizzes, exams, or projects will result in zero points for that particular activity
and possible additional disciplinary action. Suspected misconduct will be reported to the Committee on
Academic Misconduct (COAM). If COAM determines that you have violated the University’s Code of
Student Conduct (i.e., committed academic misconduct), the sanctions for the misconduct could include
a failing grade in this course and suspension or dismissal from the University.

The Ohio State University and the Committee on Academic Misconduct expect that all students have
read and understand the University’s Code of Student Conduct, and that all students will complete all
academic and scholarly assignments with fairness and honesty. Students must recognize that failure to
follow the rules and guidelines established in the University’s Code of Student Conduct and this syllabus
may constitute “Academic Misconduct.”

Examples of academic misconduct include (but are not limited to) plagiarism, collusion (unauthorized
collaboration), copying the work of another student, and possession of unauthorized materials during an
examination. Ignorance of the University’s Code of Student Conduct is never considered an excuse for
academic misconduct, so | recommend that you review the Code of Student Conduct and, specifically,
the sections dealing with academic misconduct. Please see the code

at http://studentaffairs.osu.edu/csc/ and other resources at http://oaa.osu.edu/coam.html

Disability Services

Any student who feels s/he may need an accommodation based on the impact of a disability should
contact me privately to discuss your specific needs. Please also contact the Office for Disability Services
(http://ods.osu.edu/), located in Pomerene Hall, at 614-292-3307 to discuss accommodations.


http://studentaffairs.osu.edu/csc/
http://oaa.osu.edu/coam.html

Schedule (subject to minor revisions)

Topic

Making Global Connections

Commodity Chains and
Global Capitalism

Gender and the Global
Factory

A Closer Look at China

Revisiting the Global
Factory

MIDTERM EXAM

Looking Back—Historical
Roots of Contemporary
Global Order

Looking Back—Colonialism
and its Aftermaths

Looking Back—States and
Markets through the 20t
Century

Date

Aug. 28

Sept. 2

Sept. 4 Q

Sept. 9

Sept. 11 Q

Sept. 16

Sept. 18

Sept. 23

Sept. 25 Q
Sept. 30

Oct. 2
Oct.7 Q
Oct. 9

Oct. 14

Oct. 16

Oct.21 Q

Oct. 23

Readings

Mills, “The Sociological Imagination” (in class and on
Carmen)

Where Am | Wearing? beginning - p.48
Read/watch interactive feature: “The Shirt on Your
Back” (Carmen)

Where Am | Wearing? pp.49-77

Mascarenhas, “The Genocide Behind Your Smart Phone’
(Carmen)

Pearce, “Scorched Earth” (Carmen)

)

Where Am | Wearing? pp.81-137
Sen, “How to Judge Globalism” (Carmen)

Adler, “A Job on the Line” (Carmen)
Enloe, “Daughters and Generals in the Politics of the
Globalized Sneaker” (Carmen)

Where Am | Wearing? pp.141-196
**Project #1 due**

Factory Girls chapters 1-2

Factory Girls ch. 3-4

Factory Girls ch. 5, 7 (ch. 6 is optional)
Ruwitch, “China shoe factory strike shows welfare
Achilles' heel” (Carmen)

Factory Girls ch. 8, 10 (ch. 9 and 11 are optional)
Factory Girls ch. 12, 13, 15 (ch. 14 is optional)

Where Am | Wearing pp.199-end

No reading assigned

Kloby, “The Legacy of Colonialism” (Carmen)
Gourevitch, “Stories from Rwanda” (Carmen)

Broad and Cavanagh, excerpt from Development
Redefined (Carmen)



Poverty, Inequality, and
Development

Global Environmental
Challenges

Rethinking Globalization—
Social Movements

Rethinking Globalization—
Consumer Action

Rethinking Globalization—
What can governments do?

FINAL EXAM 10:00-11:45
am

Oct. 28

Oct. 30 Q
Nov. 4
Nov. 6
Nov. 11
Nov. 13

Nov. 18 Q
Nov. 20

Nov. 25

Dec.2 Q

Dec. 4

Dec.9 Q

Fri. Dec. 12

Bearak, “Why People Still Starve” (Carmen)
Collier, excerpt from The Bottom Billion (Carmen)

Ferguson, “Governing Extraction” (Carmen)
Reading TBA

**Project #2 due**

Veteran’s Day—no classes

Rogers, “Why Biofuels Are the Rainforest's Worst
Enemy” (Carmen)

McKibben, “After Growth” (Carmen)

Havel, “An Orientation of the Heart” (Carmen)
Voss and Williams, “The local in the global: rethinking
social movements in the new millennium” (Carmen)

O’Rourke, “Citizen Consumer” (Carmen)
Reich, “Don’t Blame Wal-Mart” (Carmen)
Thanksgiving break

Maniates, "Individualization: Plant a Tree, Buy a Bike,
Save the World?" (Carmen)

)

Rodrik, “The Political Trilemma of the World Economy”
(Carmen)

Tendler, excerpt from Good Governance in the Tropics
(Carmen)
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GE Rationale for Diversity: Global Studies
SOCIOL 3597.01 World Problems in Global Context

This document specifies how each of the expected learning outcomes identified in the
course syllabus will be met across different dimensions of the course. Each outcome is
addressed separately.

Diversity: Global Studies

The first expected learning outcome for this course is: “Students understand some of the
political, economic, cultural, physical, social, and philosophical aspects of one or more of
the world's nations, peoples and cultures outside the U.S.” This outcome will be met
through:

Course objectives: Examining world problems in a global context is an especially useful lens
through which to achieve the first learning outcome. Through the course objectives
students develop: a clearer sense of their connection to individuals, communities, and
environments in other parts of the world; (2) a deeper understanding of globalization,
including its history, ideological foundations, and complex consequences; (3). substantive
knowledge of the interplay of global production and social life in particular countries; (4)
greater skill in understanding and evaluating complex written arguments, and (5) some
experience analyzing quantitative, cross-national data.

The readings. This is an intensive reading course. The readings change across terms in
response to global events and conditions and research developments. They currently
include 2 research-based books, and a mix of chapters from edited books, and research
reports. Approximately 90% of the readings focus specifically on globalization, global
production, and global social problems and draw attention to the cultural, structural,
social, economic and political factors that shape social life in countries around the world.

The topics. The topics vary in response to current events and research developments.
They currently include: (1) commodity chains and global capitalism, (2) gender and the
global factory, (3) in-depth examination of factory work and workers in China, (4)
historical roots of the contemporary global order, (5) colonialism and its aftermath, (6)
states and global markets through the 20" century, (7) global poverty, inequality, and
development, (8) global environmental challenges, (9) global social movements, (10)
rethinking globalization — what can consumers do? (11) rethinking globalization—what
can governments do?

Choose a Country: The readings and class materials provide a glimpse of a variety of places
around the world. But to develop a deeper understanding of a particular place, students
choose one of the following countries to have as a special focus throughout the semester:
Indonesia, Bangladesh, China, Cambodia, Mexico, Honduras, Democratic Republic of the
Congo. Each of these is featured in one or more of the assigned readings. Students are



asked to complete some independent reading about this country, and it is featured in their
two project assignments (discussed below).

The project reports. Students complete two projects, each of which require a written
report. In the first, they use their own consumer activities to explore links to individuals,
communities, and environments elsewhere (with a particular emphasis on their country
of choice). Students are asked to give particular attention to the ways in which their
consumer behavior influences and is influenced by political, economic, cultural, and
social factors in their country of choice (ELO 1). Students are asked to consider whether
and how this consumer behavior ties them to the global community and to the specific
cultural and social practices of the country of choice and shapes or reflects their own
values and attitudes as global citizens. (ELO2).

In the second, students analyze some data on national development and to examine
their country’s position in the global pattern. (Instructions for data analysis are
provided, so no prior skills are necessary). Students are asked to give particular attention
to the ways in which the global position of their focal country affects and is affected by
its specific political, economic, cultural, and social structures (ELO 1). Students are asked
to consider whether and how the cultural and social practices of the country of choice
and its position in the global pattern shapes their own values and attitudes as global
citizens. (ELO2).

The second expected learning outcomes for this course is, “Students recognize the role of
national and international diversity in shaping their own attitudes and values as global
citizens.” This outcome will be met through:

Course objectives: Examining world problems in a global context is an especially useful lens
through which to achieve the second learning outcome. Through the course objectives
students develop: (1) a clearer sense of their connection to individuals, communities, and
environments in other parts of the world; (2) a deeper understanding of globalization,
including its history, ideological foundations, and complex consequences; (3) substantive
knowledge of the interplay of global production and social life in particular countries; (4)
greater skill in understanding and evaluating complex written arguments, and (5) some
experience analyzing quantitative, cross-national data.

The readings. This is an intensive reading course. The readings change across terms in
response to global events and conditions and research developments. They currently
include 2 research-based books, and a mix of chapters from edited books, and research
reports. Approximately 90% of the readings focus specifically on globalization, global
production, and global social problems and draw attention to diversity in the cultural,
structural, social, economic and political factors that shape social life in countries around
the world. Attitudes and values are core components of culture and the strong attention
to cross-cultural differences and their link to global social problems provides a solid



foundation from which students are asked to consider how their own cultural values are
shaped by their growing links to the global community.

The topics. The topics vary in response to current events and research developments.
They currently include: (1) commodity chains and global capitalism, (2) gender and the
global factory, (3) in-depth examination of factory work and workers in China, (4)
historical roots of the contemporary global order, (5) colonialism and its aftermath, (6)
states and global markets through the 20" century, (7) global poverty, inequality, and
development, (8) global environmental challenges, (9) global social movements, (10)
rethinking globalization — what can consumers do? (11) rethinking globalization—what
can governments do?

Choose a Country: The readings and class materials provide a glimpse of a variety of places
around the world. But to develop a deeper understanding of a particular place, students
choose one of the following countries to have as a special focus throughout the semester:
Indonesia, Bangladesh, China, Cambodia, Mexico, Honduras, Congo (DRC). Each of these is
featured in one or more of the assigned readings. Students are asked to complete some
independent reading about this country, and it is featured in their two project assignments
(discussed below).

The project reports. Students complete two projects, each of which require a written
report. In the first, they use their own consumer activities to explore links to individuals,
communities, and environments elsewhere (with a particular emphasis on their country
of choice). Students are asked to give particular attention to the ways in which their
consumer behavior influences and is influenced by political, economic, cultural, and
social factors in their country of choice (ELO 1). Students are asked to consider whether
and how this consumer behavior ties them to the global community and to the specific
cultural and social practices of the country of choice and shapes or reflects their own
values and attitudes as global citizens. (ELO2). Complete project assignments are listed in
Appendix 1

In the second, students analyze some data on national development and to examine
their country’s position in the global pattern. (Instructions for data analysis are
provided, so no prior skills are necessary.) Students are asked to give particular
attention to the ways in which the global position of their focal country affects and is
affected by its specific political, economic, cultural, and social structures (ELO 1).
Students are asked to consider whether and how the cultural and social practices of the
country of choice and its position in the global pattern shapes their own values and
attitudes as global citizens. (ELO2). Complete project assignments are listed in Appendix
1



GE Assessment Plan

Assessment Plan for Expected Learning Outcome #1: “Students recognize the role of
national and international diversity in shaping their own attitudes and values as global
citizens.”

Direct Method: This learning outcome will be assessed via the two written project reports.
Each includes a component that directly addresses this ELO.

Level of Student Achievement Expected: 75% of students achieve the ELO at a “Milestone 2”
standard on a scoring rubric for at least one of the two project reports (equivalent to a
grade of C).

Process used to review the data and potentially change the course to improve student
learning: For all students who do not meet the ELO at the expected level, the instructor will
review the attendance, participation, and initiative of each student in seeking help in office
hours and evaluate whether student motivation and initiative was a likely factor in the
student not meeting the objectives. If the number of students who do not meet the ELOs is
small and largely composed of students with poor attendance and/or participation, no
action will be taken. If the number of students who do not meet the ELOS is large and/or
largely composed of students with strong participation and attendance, the instructor will
review course content, readings, and instruction to determine if alternative pedagogical
methods may be warranted to improve student learning.

Assessment Plan for Expected Learning Outcome #2: “Students recognize the role of
national and international diversity in shaping their own attitudes and values as global
citizens.”

Direct Method: This learning outcome will be assessed via the two written project reports.
Each includes a component that directly addresses this ELO.

Level of Student Achievement Expected: 75% of students achieve the ELO at a “Milestone 2”
standard on a scoring rubric for at least one of the assignment (equivalent to a grade of C).

Process used to review the data and potentially change the course to improve student
learning: For all students who do not meet the ELO at the expected level, the instructor will
review the attendance, participation, and initiative of each student in seeking help in office
hours and evaluate whether student motivation and initiative was a likely factor in the
student not meeting the objectives. If the number of students who do not meet the ELOs is
small and largely composed of students with poor attendance and/or participation, no
action will be taken. If the number of students who do not meet the ELOS is large and/or
largely composed of students with strong participation and attendance, the instructor will
review course content, readings, and instruction to determine if alternative pedagogical
methods may be warranted to improve student learning.




Project Report 1

Capstone (4)

Milestone (3)

Milestone (2)

Benchmark (1)

(ELO1)

Students understand
some of the political,
economic, cultural,
physical, social, and
philosophical aspects
of one or more of the
world’s nations,
peoples and cultures
outside of the United
States

Critically analyzes and
applies knowledge of
the role of economic,
cultural, physical,
social or philosophical
aspects of the country
of choice ( peoples and
cultures outside of the
United States) in
relation to their
consumer behavior

Explains the role of
economic, cultural,
physical, social or
philosophical aspects
of the country of
choice ( peoples and
cultures outside of the
United States) in
relation to their
consumer behavior

Describes with some
depth the role of
economic, cultural,
physical, social or
philosophical aspects
of the country of
choice ( peoples and
cultures outside of the
United States) in
relation to their
consumer behavior

Superficially describes
of the economic,
cultural, physical,
social or philosophical
aspects of the country
of choice ( peoples and
cultures outside of the
United States) in
relation to their
consumer behavior

(ELO2)

Students recognize
the role of national
and international
diversity in shaping
their own attitudes
and values as global
citizens.

Critically analyze how
their consumer
behavior ties them to
the global community
and to the specific
cultural and social
practices of the
country of choice and
shapes or reflects their
own values and
attitudes as global
citizens.

Explain how their
consumer behavior
ties them to the global
community and to the
specific cultural and
social practices of the
country of choice and
shapes or reflects their
own values and
attitudes as global
citizens.

Shows some
awareness of the ways
in which their
consumer behavior
ties them to the global
community and to the
specific cultural and
social practices of the
country of choice and
shapes or reflects their
own values and
attitudes as global
citizens.

Shows little awareness
of the ways in which
their consumer
behavior ties them to
the global community
and to the specific
cultural and social
practices of the
country of choice and
shapes or reflects their
own values and
attitudes as global
citizens.

See Appendix 1 Project Report 1 for the full assignment




Project Report 2

Capstone (4)

Milestone (3)

Milestone (2)

Benchmark (1)

(ELO1)

Students understand
some of the political,
economic, cultural,
physical, social, and
philosophical aspects
of one or more of the
world’s nations,
peoples and cultures
outside of the United
States

Critically analyzes and
applies knowledge
about the ways in
which the global
position of their focal
country affects and is
affected by its specific
political, economic,
cultural, and social
structures

Explains the ways in
which the global
position of their focal
country affects and is
affected by its specific
political, economic,
cultural, and social
structures

Describes with some
depth the ways in
which the global
position of their focal
country affects and is
affected by its specific
political, economic,
cultural, and social
structures

Superficially describes
of the ways in which
the global position of
their focal country
affects and is affected
by its specific political,
economic, cultural, and
social structures

(ELO2)

Students recognize
the role of national
and international
diversity in shaping
their own attitudes
and values as global
citizens.

Critically analyzes how
the cultural and social
practices of the
country of choice and
its position in the
global pattern shapes
their own values and
attitudes as global
citizens.

Explains how the
cultural and social
practices of the
country of choice and
its position in the
global pattern shapes
their own values and
attitudes as global
citizens.

Shows some
awareness of the ways
in which the cultural
and social practices of
the country of choice
and its position in the
global pattern shapes
their own values and
attitudes as global
citizens.

Shows little awareness
of the ways in which
the cultural and social
practices of the
country of choice and
its position in the
global pattern shapes
their own values and
attitudes as global
citizens.

See Appendix 1 Project Report 2 for Complete Assignment




1. APPENDIX 1: Project Report Assignment 1 and 2



Project Assignment 1: World Problems in Global Context

Prof. Bartley

Project #1: Commodities and Connection

Due: Thursday, September 18 (as a hard copy, turned in at the beginning of class time)
25 points possible

In this project, you will explore the ways in which your consumer behavior connects you to
people and places in other parts of the world, eventually honing in on and learning about
your country of choice. Your final product should be a typed document that reports on each
of the tasks below. Please use section headings (like those below) in your report.

When the instructions ask you to make a list, please simply make a list in your report. But
when the instructions ask you to write about something, please be sure that you write in
clear and complete sentences. Your report will be graded both for content and for the
quality of your writing. Please read and revise your work before submitting it.

Please also re-read the section of the syllabus on academic integrity. Plagiarism—
intentional or unintentional—or other misconduct will result in a zero for this assignment
and possible additional disciplinary action. Except when you are asked to list something
verbatim, you will need to absorb enough information about a given topic to write about it
in your own words.

You may not use direct quotations in the writing sections of this assignment. You must
write in your own words. (This is especially important for Part 2)

Part 1: Inventory

For a three day period, keep a log of what you wear, eat, and use—and as much as possible
about where it was made. (Clothes and shoes should have the country of manufacturing on
the label. Whole fruits, vegetables, meat, and fish should also.) Make notes in your log as
you go through the day, and then return to it at night to make sure you haven’t forgotten
anything.

In your report, please list 10 items that you wore, ate, or otherwise used and the country or
countries that they (or their ingredients) came from. If you could not tell from the item
itself where it was made, do some internet searches to find out where that item (and/or its
components or ingredients) is commonly produced. If you are still not sure, include your
best guesses about where that product was made (and the reasoning behind them). If you
have kept a log for three days, it should be easy to list 10 items for which you have
knowledge or a very good guess about the country of origin.

Choose two of the countries on your list (apart from the U.S. and your chosen country) and
write two brief paragraphs describing what you know or think about them currently. (You
should write a separate paragraph for each country.) You should not do any research on
these countries. Instead, the point is simply to reflect on what you already know about
them. (You may write whatever you know about the country, but you may want to consider
questions like the following to get your thinking started: What have you learned about it in
your previous education (or already in this class)? Have you seen a movie from that
country? Have you met people from this country? Have you seen it in the news recently? If



so, why? Note: Detailed knowledge is not necessary. If you do somehow have very detailed
knowledge of the country, please be sure to explain how you gained it.)

Part 2: Your chosen country
A. Your connection

Now consider the country that you have chosen (from the list provided on the syllabus) to
be your focus this semester. Were any of the items you listed above produced in your
chosen country? (Remember that some products are made up of many components or
ingredients that come from different places. Even if only a small part of a product came
from your country, that is relevant.)

If so, list the items that link you to this country. If not, list a few items made in that country
that you might have consumed. (Use some internet searches to find out what products are
most commonly exported from that country to the U.S.)

Now write one paragraph describing what you already know about your chosen country.
The goal is the same as the paragraphs you wrote in the previous section: Simply discuss
what you already know. (Once again, you may want to consider questions like the following
to get your thinking started: What have you learned about it in your previous education (or
already in this class)? Have you seen a movie from that country? Have you met people from
this country? Have you seen it in the news recently? If so, why?)

B. Historical and political-economic context

In this section, you will take two steps to learn more about your chosen country, and then
write an essay about what you’ve learned.

First, look up your country in the CIA’s World Factbook
(https://www.cia.gov/library/publications/the-world-factbook/). This will provide some
brief but useful points of information about your country. Take notes (for yourself) on
issues like the following:

e Was the country colonized? If so, when and by whom? (And can you tell why it was
attractive as a colony (i.e., for particular natural resources, geographic position,
etc.)?)

e  When did the country attain independence (or when was it founded)?

e Has the country been called other names in the past 100 years? (If so, note them.
You will need to use them in the next step.)

e Has the country experienced wars in the past 50 years?

e What industries are most important?

o How have political circumstances influenced the country’s economic activity? (Or
how has economic activity influenced politics?)

Second, find articles in the New York Times about what was going on in your country in the
1970s, 1980s, and 1990s. To ensure full-text access, use the OSU library’s database:
ProQuest Historical Newspapers: The New York Times, 1851-2010. Use an advanced search


https://www.cia.gov/library/publications/the-world-factbook/

so that you can specify the dates. You can get directly to this by using the following link
(which you can paste from the electronic version of this document posted on Carmen):

http://search.proquest.com.proxy.lib.ohio-
state.edu/hnpnewyorktimesindex/advanced?accountid=9783

In your report, list 5 headlines from stories about your country in the 1970s, 5 from the
1980s, and 5 from the 1990s. Be sure to include the year of publication along with the
headline. Do as much as possible to cover different parts of each decade. (For instance,
don’t have all 5 articles from the 1970s be from 1972). If your country experienced name
changes, you will need to search for the older name to find the older articles.

From those you listed, choose one article from each decade to read. Mark the headlines that
you have chosen with an asterisk or otherwise indicate which stories you have read.) Be
sure to choose articles that you think will give you some insight into the country’s history
and/or political-economic situation.

Now, integrating what you have learned from the World Factbook and the New York Times
articles, write a short essay (roughly 1-2 pages double-spaced) about what you see as the
most important features of your country—and perhaps also what you found both important
and surprising. This part of the essay should reflect only what you learned from these
sources.

Finally discuss what you have learned about the ways in which your consumer behavior
influences and is influenced by political, economic, cultural, and social factors in their
country of choice. In doing so, consider whether and how this consumer behavior ties them
to the global community and to the specific cultural and social practices of the country of
choice and shapes or reflects their own values and attitudes as global citizens.

Part 3: Recommended but not required

Movies and documentary films can provide important glimpses into some of your countries.
If this project has piqued your interest, I recommend that you get together with your group
members to watch and discuss the following films. This is not light viewing, and some of
these films depict harsh and violent settings. But engaging with these films can be a
powerful first step in learning more about a country.

Many of these films are available through the OSU library or through Netflix, Hulu Plus,
Amazon, or elsewhere online. If you have trouble finding any of them please let me know.

Last Train Home (2009 documentary film on China)

The Missing Picture (2013 film about Cambodia)

The Act of Killing (2012 film about Indonesia)

Lumumba (2000 film on the Democratic Republic of the Congo)

Maquilapolis: City of Factories (2006 documentary about Mexico)

The Ambassador (documentary about Honduras, only available in Spanish online here:
http://www.arcoiris.tv/scheda/es/1158/)
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World Problems in Global Context
Project #2
Due Thursday, Nov. 6 as a hard copy at the beginning of class

In this project, you will be analyzing some quantitative, cross-national data on
development. You will look at your chosen country, at larger-scale patterns, and at
your country’s position in the larger pattern. No prior data analysis experience is
necessary, but it is crucial that you follow these instructions very carefully. The
instructions are long, but if you use them well, the time it takes to complete this
project should be relatively short.

The data we will be using are available from www.gapminder.org. Gapminder
compiles national data on development from a variety of sources, including the
United Nations, World Bank, and others.

You will need to use Microsoft Excel to analyze the data. If you do not have it on
your own computer, you can use Excel in computer labs across campus. Excel is
widely used, so I hope the data analysis skills you develop in this project will prove
useful later on. Note that the instructions below refer to the Windows version of
Excel. The Mac version of Excel works slightly differently. You may use the Mac
version if you prefer, but be aware that you will need to be very careful when
sorting the data, and some alteration of the commands may be necessary. My
recommendation is to use the Windows version if possible.

Please save the Excel files that you work with in a place that you can find them later.
[ will ask you to email them to me if questions arise when I'm grading.

Part 1: Women’s literacy rates, 2007-2011

The goal here is to briefly look at the percentage of adult women who can read in
your chosen country. In Gapminder, this is called “Literacy rate, adult female (% of
females ages 15 and above).”

1. Go to Data in Gapminder, find this variable, and download the data as an Excel file.
2. In the Excel file, delete all of the columns except for the list of countries and the
years 2007-2011. (Select them, then right-click and choose Delete (not Cut)). We
will just focus on this recent period.

3. Find the literacy rate for women in your country, and record this in your report.
Use the most recent data available for your country.

4. Using the same year as above (the most recent one available for your country),
sort the countries by their literacy rate for women. Select the column, then choose
Data > A-> Z (smallest to largest) (or Z = A if you prefer), and do expand the
selection (as prompted).

5. Write a brief description of how your country compares to others in terms of
women’s literacy. Does it fall toward the top or toward the bottom of the
distribution? What similar countries do you notice as having much higher or lower
women’s literacy rates?
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Part 2: Trends over time

1. Choose one of the following variables to examine:
a. Income per person (GDP/capita, PPP$ inflation-adjusted) (also known as GDP per capita
by PPP)

***Delete everything up to 1970. Data is sparse until that point.

**Note that “per capita” just means “per person.

**Be sure to use this version.

b. Human Development Index (HDI)
**Use the documentation in Gapminder to see what this means.

c. Child mortality (0-5 year-olds dying per 1,000 born)
***Delete everything up to 1970. Data is sparse or based on rough estimates at earlier
points.

2.In the Gapminder data section, find this variable and download the appropriate
Excel file. Open it and delete the early years if necessary, as noted above.)

3. You will need to create a new sheet, containing only the years and the data for
your chosen country. But don’t delete all the rest, since you'll need it in step 8
below. Instead, copy and paste the top row and the row for your country into a new
sheet. To make things clear, change the labels in the first cell in each row, so that
the first says “year” and the second says “[your country, your variable].”

4. Now make a chart of the trend in your country. To do this, select both rows. Then
go to Insert > Scatter (under charts) > Scatter with smooth lines. (Be sure to choose
the Scatter type of chart. Choosing a Line chart will make things much messier and
almost impossible to format appropriately.)

5. You should now see a chart of the trend over time. Copy and paste it into your
report.

6. Write a brief description of what the chart shows. This should be written in a way
that would make sense to someone who didn’t know what your variable was or how
it was measured. You will need to click on the variable in Gapminder to find out
how it was measured. It is permissible to use a direct quote from Gapminder’s
description, but please be sure to put it in quotation marks (and cite Gapminder).

7. Now think about two countries that you think would make for interesting
comparisons with your country. (Think about the comparisons that have been made
in the readings, lectures, and discussions for this class. You should have a well-
reasoned rationale for your choices.) Describe the rationale for your comparison in

your report.

8. Copy and paste your two comparison countries’ data into the sheet with your
country’s data. Make sure everything is in order, and then make a chart showing the
trend in all three countries. This can be done just as you did above—Dby selecting
the data and using a Scatter with smooth lines chart. Please edit the axis once again.
9. Copy and paste this chart into your report.

10. Write a brief description of what the chart shows.
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Part 3: Income and child mortality in 2010

In this part, you will look at the relationship between countries’ level of income per person
(GDP/capita, PPP$ inflation-adjusted) and their rate of child mortality (number of 0-5 year-
olds dying per 1,000 born) the year 2010. As you might expect, wealthier countries tend to
have lower rates of child mortality than do poorer countries.

You will have to do a little work to get the data in the right format to do this analysis.
Follow the steps below very carefully.

1. In Gapminder, find these two variables and download the Excel files with this data. You
will have two separate files at this point.

2.In each file, delete everything except the country names and the data for 2010.

3. To fix a few mistakes in the files, do the following:
a. Delete Nagorno-Karabakh and its data cell from both lists (and shift cells up).
b. Delete South Sudan and its data cell from both lists (and shift cells up). (Note that it is
out of alphabetical place on the child mortality list.)
c. Rename the columns so they describe what lies below. (In other words, call the first
column “country and the second column “income per capita” or “child mortality.”)

4. Now paste the countries and data from the Child mortality file into the Income
file. (Put them to the right of the income data. This will ensure that things work
smoothly later on.) Make sure that the countries match all the way down the list. If
not, fix the lists so that they do match. (Once you’ve done that, you can delete the
extra Country column if you want, but be sure that you have one column of
countries remaining.)

5. We will restrict our analysis to middle- and lower-income countries. To do this,
first sort the file by Income. Click on the top of the income column, the select Data >
Z = A (largest to smallest) and do expand the selection (as prompted by Excel).
Then select and delete all rows for countries with incomes higher than 14,000.

6. You should now have a list of low- and middle-income countries, their income per
capita, and their rate of child mortality. (Don’t worry about any countries with
missing data that are left dangling. They will simply be ignored when Excel does the
analysis.) In the steps below, you will analyze the relationship between income and
child mortality by making a scatterplot.

7. Select the columns for income and child mortality. (But do not select the Country
column.) Choose Insert > Scatter > Scatter with only markers (the top option).
Notice that this is a different kind of scatterplot than what you used in part 1. If
you’ve done everything right, you should see a plot with income graphed on the X
axis (horizontally) and child mortality graphed on the Y axis (vertically). Each dot
represents a country.

8. Click on the title at the top of the plot and change it to something more accurate,
like “Relationship between income and child mortality in low- and middle-income
countries.” Also, it is recommended that you increase the size of the chart to make it
easier to examine.
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9. Now tell Excel to add a line showing the average relationship. (For those who
have taken stats, this is like the “regression line.”) Do this by clicking on one of the
data points, then right-click and choose Add trendline. Then select Exponential and
close. (For those who have taken stats, as you can see, the pattern is not quite
linear, so an exponential curve is a good choice for this scatterplot. A polynomial
(squared term) could also work.)

10. Copy and paste the scatterplot into your report.

11. Write a description of what the chart shows. What is the overall pattern? Once
again, this should be written so that it makes sense to someone who is not familiar
with the data you are analyzing or how your variables are measured.

12. Locate your country in this pattern and label it on the scatterplot in your report.
To do this, you will need to find the coordinates for your country in the Excel file,
then poke around with the mouse in that region to find the exact point that
represents your country.

13. Write a description of where your country lies in the broader pattern. In
addition, how has your country fared relative to the average relationship between
income and child mortality. (Hint: Look at whether your country is above or below
that line in the scatterplot—and think about what that means.) In other words,
when it comes to minimizing child mortality, has your country under-performed or
over-performed given its income level? Finally, based on what you know about the
country already, can you think of any reasons why it may have under-
performed/over-performed? Give particular attention to the ways in which the global
position of their focal country affects and is affected by its specific political, economic,
cultural, and social structures. Discuss whether and how the cultural and social practices
of your focal country and its position in the global pattern shape your perception of the
country and your assessments of why it may have over- or under-performed on this
dimension?

Finally, double-check to make sure you have completed all the steps and that your
report is orderly. You should print out and turn in a hard copy of your report.
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